
RELEASE NOTES OF NEW FEATURES AND ENHANCEMENTS 

FOR TRIALDIRECTOR VERSION 6.2.896

PRESENTATION

Additional Layouts for Displaying Synchronized Video

Closed Caption Layout now provides the option to display transcript text below the video screen rather 
than on top of the video. To select this layout, access Presentation Preferences from the View menu, 
select the Exhibits tab and choose ClosedCaption2.     

Classic Layout now provides the option to display up to 12 lines of transcript text below the video and 
choice of highlight color. To select this layout, access Presentation Preferences from the View menu, 
select the Exhibits tab and choose Classic2.

www.indatacorp.com | 800.828.8292



Video Clip Segment Indicator

A segment indicator is now available in the upper right corner of the video window. 

To display the Segment indicator, access Presentation Preferences from the View menu, select the 
Exhibits tab, and choose Show Segment Indicator in the General section of the Digital Video Transcripts 
preferences. The segment indicator also can be turned on/off using the SHIFT+CTRL+F12 keystroke 
combination.

Shortcut Segment Navigation Commands

Use the –SG command to navigate to a specific segment (for example, –SG4).  

Use the –NS command or the SHIFT+F12 keystroke combination to move to the next segment in 
sequence.

Detached Tool Box Control

The new VCR control can be detached and moved to any location on any display. It can be used with docu-
ments, Synchronized Video Clips, Multimedia, Carousels and with the Detached Toolbar or Presentation 
Tools palette as shown below.
  
The new Detached Control Tool Box is also dynamic, automatically adjusting to the content type displayed 
in the selected zone.

To enable the Detached Tool Box, select the Detached Tool Box item under the toolbar button in 
Presentation mode. 
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Control Tool Box for PDF or Imaged Document, docked below Presentation Tools Palette

 Control Tool Box for Multi-Segment Synchronized Video Clip

Control Tool Box for Multimedia

“Fit to Page Width” and “Fit to Full Page” Toolbar Buttons

Use these tools to quickly zoom to the top half of an image or display the full page. Both tools are found in 
the Application Tool section of the Presentation Toolbar

 New “Fit to Page Width” and “Fit to Full Page” toolbar buttons

Shortcut to Last Page of a Document in Presentation Mode

Use the –PG999 command to immediately jump to the last page of a document in Presentation Preview or 
Presentation Mode.
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Presentation Mode Icon on Windows Taskbar

Click this icon  to quickly switch focus to the full presentation screen. To close the Presentation 
Mode, right-click on the Presentation Mode icon in the Windows taskbar.

Presentation Link in Windows Start Menu
Direct access to Presentation Mode is now possible via a new shortcut available within the TrialDirector 6 
Start Menu program group, as shown below.

Easier to Use Text Box Annotation Tool in Presentation Mode

The Text Box annotation tool   now opens in edit mode when placed on an image, graphic, document, 
video or synchronized video clip, allowing the user to immediately start typing text. The Text Box can be 
customized by choosing a text color prior to placement (right-click on the Text Box tool to access the color 
palette). When the text box is re-sized or line feeds are added, the font scaling adjusts automatically.

ALT+E Keystroke Dismisses Non-Redaction Annotations

When using the ALT+E keystroke in Presentation Preview or Presentation Mode, any redactions contained 
on the image remain intact while all other annotation types (highlights, arrows, ellipses, stamps, etc.) are 
immediately removed.  Please note that annotations placed within active callout projection windows are not 
impacted by this command.

Multi-Play Workbooks Automatically Close Last Synchronized Video Clip or 

Multimedia Item

Multi-play workbooks now close the final Synchronized Video Clip or Multimedia Stream when the 
Shutdown Behavior for the respective item type is set to Close within the Presentation Preferences.

New Shortcuts for Navigating to a Specific Page/Line Range of a 

Synchronized Video Clip in Presentation Mode

Keyboard Commands: The –PG command is now recognized as a navigation tool by the Synchronized 
Video and Transcript presentation controls. Simply enter the page-line reference, separated by a period 
(or colon) to navigate. (Ex. –PG249.22) 
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Point and Click Commands: Users can now simply scroll down to a portion of the transcript they wish 
to access, double-click on a particular line and the synchronized video will immediately jump to that 
location.  The user can then begin playback from that location by either double-clicking on the video 
window or via the play button within the Synchronized Video Control Toolbox.

Streamlined Admitting of Exhibits in Presentation Preview or Presentation 

Mode

An Admitted Workbook is now automatically created when creating a new case, which enables the Admit 
Exhibit commands (-AD, -AE, ALT+Insert) to automatically add new items to both the Admitted Workbook 
and the Coding database, if applicable.

Zone Mode and Push Zone Mode Function Keys Consistent with Previous 

TrialDirector Versions

The F11 key now activates Push Zone Mode and F12 activates Replace Zone Mode. 

Ability to Pan Zoomed Document Using Arrow Keys

Improved Communications between the Main TrialDirector Module and Pre-

sentation Mode

Whether you change wired networks, disconnect from the network or a join wireless network, you can now 
expect IP communications between the main TrialDirector application and Presentation Mode to remain 
intact.

Caption Box Font Size Maintained While Navigating Documents

Improved Performance Navigating Documents via Page Up / Page Down 

Keys

Responsiveness to repetitive Page Up / Page Down keystrokes in Presentation mode is improved. Trial-
Director displays blank (grey) pages as the user repetitively hits the Page Up / Page Down keys. Once the 
desired page is reached, the image is immediately displayed.
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Optional Square-Corner Projection Callout Window

This new callout style will complement the existing Rounded, Capsule and Tear Out styles. Select the 
Classic Projection Zoom icon within the Callout Zoom Type menu.

 Callout Zoom Type Menu

New Square-Corner Projection Callout Style

Improved Save Stage Zooms When Crossing Two Document Pages

When creating a Save Stage item containing a zoomed region that crosses over two document pages, the 
coordinates and zoom level information are now preserved more accurately.

Ability to Expand Zone via Keystroke in Mirror Mode

Users can now expand the active zone in both the Presentation Preview and Presentation Mode via the 
SHIFT + Insert keystroke when running Mirror Mode.

Updated Presentation Workbook Icons for Microsoft Office 2007-2010 

Document Types

The appropriate icons for Microsoft Office 2007-2010 .XLSX / .DOCX / .PPTX file types now appear within 
the presentation workbooks.

Improved Performance When Dismissing an Image with Active Annotations 

within a Callout Projection Window

Memory utilization is improved within Presentation Preview and Presentation Mode when repeatedly dismiss-
ing images with active native annotations in a callout projection window.



Improved Performance Creating Save Stage Items

Users can now rapidly create Save Stage items without any application delays in Presentation Mode or the 
Workbooks Explorer.

Improved Performance Loading Large Page Count Documents with Pre-

Treated Annotations

The time required to load PDF and TIFF documents with multiple pre-treated annotations in multi-page mode 
is reduced significantly. The pre-treated annotations can be saved on a single page or on all pages of a 
document.

Ability to View Uncompressed TIFF Images

TIFF image files without any type of compression (G3, G4, LZW, Huffman etc.) can now be viewed in Pre-
sentation Preview and Presentation Mode.  However, it is still recommended that TIFF images be com-
pressed to reduce file size and further improve performance.

Ability to View TIFF Images Using New JPEG Compression Formats

Improved Performance Loading and Playing Back Synchronized Video Clips 

with Large Numbers of Attached Exhibits

Improved Performance Loading Synchronized Video Clips

Improved Performance Loading Multimedia Items (MPEG, WMV, MP3, etc.)

Improved Performance Loading Text-Only Transcripts (aka Virtual Clips)

Improved Performance Loading Imaged Documents (TIFF, PDF & JPEG)

Improved Page Positioning when Navigating Documents in Multipage View

When using the CTRL + Page Up / Page Down keystrokes to navigate a document in side-by-side mode, 
the image loads in the center of the zone and automatically adjusts to the correct aspect ratio (letter, legal, 
landscape etc.) and orientation.



TRANSCRIPT MANAGER

New “Seek to Start” and “Seek to End” Buttons Added to Clip Editor

To quickly verify accurate clip beginning and endings, a user can select the Seek to Start button to jump to 
the beginning of the current clip segment and the Seek to End button to jump to a point 3 seconds prior to 
the end of the segment.

 ”Seek to Start” and “Seek to End” buttons within Clip Review tab

Visual Segment Editor (Audio) Now Synchronized with Video

When relocating the yellow dotted line to a new audio position in the Visual Segment Editor, the displayed 
video also seeks to the same location.

Ability to Automatically Adjustment Segment Start Times

This option is available through the Adjust Start Time By setting on the Clips tab of Options.

Improved Ability to Remove Attached Exhibits from a Transcript

Improved Accuracy of Timecode References when Attaching Exhibits



Ability to Scroll Text While Editing Clips

Users can now view scrolling transcript when using the Segment Editor.  For example, when the user clicks 
the Play button for the segment end time, the text area automatically scrolls so the user can view the text 
associated with the end of the segment.

DOCUMENT MANAGER

Additional PDF Export Option

Users now have the option to create a single PDF file for all selected pages or to maintain the existing work-
book structure and create a separate PDF for each document by selecting Create a new PDF file for each 

document option.

EXAMPLE

The user wishes to export the witness folder which contains 14 items from eight documents. When the ex-
port is completed, eight unique PDF files are created.



Ability to Include Multimedia Items in Exports to PDF

When creating a PDF file with multimedia items, a frame capture from the video file will be used as a place-
holder in the output PDF file. This functionality is now consistent with selected Synchronized Video Clips.

Improved Stability Drawing Annotations Under Windows Vista    

and Windows 7

Modified Keystrokes to Save Annotations and Revisions

SHIFT+CTRL+S saves annotations on the current image. SHIFT+CTRL+R saves annotations to a separate 
image revision, leaving the original image untouched.

Accurate Export of Pack & Go Items to the Default Location 

When using the default “My Documents” path for the Pack & Go feature, all case databases, images, native 
documents and multimedia are now properly exported to the correct path.

Improved Functionality Printing Selected Items From the Document Manager 

Grid

Ability to View TimelineXpress (.TLF) Files

Improved Case Library Scrollbar Functionality

When using the scroll bar for the Case Library Explorer tree, users are now able to navigate past the top-
most location after opening a case or modifying the contents of the tree.

INTEGRATION

iConect®

Users may now double-click on .CDS files downloaded from iConect to automatically add document image 
and coding data directly to a new or existing TrialDirector 6 case.

LiveNoteTM 10, West LiveNoteTM 2.0 and West Case NotebookTM 2.0

Users may now a) send LiveNote transcripts and annotations (transcript selections) directly to a new or 
existing TrialDirector 6 case, and b) automatically present LiveNote annotations as clips. Also, support for 
limited user accounts to send LiveNote annotations to Transcript Manager has been added.



AD SummationTM

Document Manager now accurately detects which selected Summation records do not have any associated 
image files when using the Get Summation Image Info feature. This improvement prevents Document Man-
ager from importing selected Summation records without a valid IMGINFO table entry.

UTILITIES

Ability to Batch Import Entire Directory of LiveNoteTM PTF files

Simply launch the utility from the Tools menu, select a TrialDirector case and the folder containing the PTF 
transcripts.

Ability to Brand Footers on Multi-Page TIFF Files

The Image Brander utility will brand and sequence all pages of multi-page TIFF files when using the %N% 
token.

High Quality MPEG-1 Export Option Added to DVD Extractor and MPEG 

Video Transcript Utilities

This new output option will create MPEG-1 files using high resolution (720 x 480) video size, 4000Kbps 
video bitrate and a 224Kbps audio bitrate. This option is appropriate for creating high-quality MPEG-1 files 
from DVD-Video and MPEG-2 files.This option maintains the wide compatibility of the MPEG-1 format, while 
utilizing higher resolution and bitrates for a playback quality similar to DVD-Video.
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